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Теория Мэша
Для начала рассмотрим из чего состоит мэш и введем термины, которыми изобилует как данное руководство, так и сам плагин.

Мэш
Мэш (он же сетчатый градиент, он же Mesh, он же объект с именем <Mesh> или <Сетка> в палитре Layers/Слои) – векторная 

«субстанция», позволяющая реализовывать плавные (и не очень) цветовые переходы сложной формы, которых нельзя довиться 
обычными градиентными заливками (линейными или радиальными).

В основе любого мэша, каким бы хитроформенным он ни был, лежит прямоугольная сетка. Например, радиальный мэш:

Сетка состоит из некоторого числа ячеек, распределенным по «строкам» и «столбцам».
Если число «столбцов» равно M, а «строк» - N, то общее число ячеек мэша равно MxN.

Ноды
Каждая ячейка имеет по четыре нода – узла, задающего форму и окрас ячейки. Между двумя соседними нодами находится сегмент 

ячейки. Сегментов ячеек тоже четыре.

Некоторые ноды являются общими для нескольких ячеек.
Нод может быть общим только для одной, двух или четырех ячеек.
Нод, общий для одной ячейки, называется угловым. В любом мэше таких нодов ровно четыре.
Ноды, общие для двух ячеек, находятся на границах мэша (но не в его углах, где обитают угловые ноды).
Ноды, общие для четырех ячеек, уютно поселились внутри мэша.

“строки”

“столбцы”

сегменты

ноды



5

У нодов есть направляющие. Они задают форму сегмента ячейки и характер цветового перехода между цветами нодов.
Направляющих у нода может быть две, три или четыре (в соответствии с тем, для скольких ячеек нод является общим).

Вертексы
Для придания сегментам мэша более заковыристых форм, на них могут находиться вертексы.
Вертексы – это дополнительные узлы, имеющие по две направляющие. Вертексы задают форму сегментов, характер цветового 

перехода (при помощи направляющих), но не сам цвет. За цвет отвечают исключительно ноды.

Кноты
Кроме того есть одна разновидность вертексов – кноты.
Кнот выполняет те же функции, что и вертекс, с той лишь разницей, что кнотом нельзя управлять напрямую. А, пытаясь управлять не 

напрямую, невозможно получить желаемых результатов.
Увидеть кноты на мэше можно только если выбрать инструмент “Add Anchor Point Tool ” или “Delete Anchor Point Tool ”. Его 

направляющие увидеть невозможно (без дополнительных манипуляций).
Кроме того, при наличии кнота между узлами (вертексами и/или нодами), направляющие этих узлов не соответствуют их настоящим 

направляющим (совпадает только направление).

Оси и направления
Один из угловых нодов является начальным нодом мэша. Из него условно исходят две оси (на подобии координатных осей): ось I, 

проходящая вдоль «строк» мэша, и ось J, проходящая вдоль «столбцов».
Возможны четыре направления движения вдоль сетки мэша: I, I’, J, J’

вертекс

“настоящие”
направляющие

направляющие, которые
отображает Illustrator

кнот

I

J

I

J II’

J

J’
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Сегменты
Будем различать термины “сегмент“ и “сегмент ячейки“.
Сегмент - это кривая, задаваемая двумя соседними узлами мэша (нодами и/или вертексами).
Сегмент ячейки - это совокупность всех сегментов, находящихся между двумя соседними нодами.
Если между двумя соседними нодами нет вертексов, то сегмент ячейки состоит из одного простого сегмента.
Если между двумя соседними узлами (нодами и/или вертексами) находится кнот (или кноты) то вся эта кривая считается одним 

сегментом.

Регион
Регион – это минимальная «прямоугольная» (относительно структуры сетки мэша) область, в которую попадают все выделенные 

ноды и вертексы.

Простой регион
Простой регион учитывает только выделенные ноды.

Регион 0xN
Частный случай региона, все ноды и вертексы которого находятся на одной линии мэшевой сетки. Некоторые функции плагина Mesh-

Tormentor с регионами 0xN работают иначе, чем с регионами, не являющимися 0xN.

- нод
- вертекс
- кнот

сегменты

сегменты ячеек
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Дополнительная информация о мэшах
Немного больше о кнотах
Если пользоваться штатными средствами Illustrator-а, по получить на мэше кноты можно следующими способами:
- если удалить некоторые линии сетки (уменьшить плотность сетки), выделив нод/ноды и нажав клавишу Delete на клавиатуре (либо 

кликнув по нодам инструментом “Mesh Tool ” с зажатой клавишей Alt)

- в Illustrator CS6 при вызове Object -> Expand Appearance градиентные обводки превращаются в мэши (за исключением самого 
простого варианта градиентной обводки) на которых может быть предостаточно много кнотов.

Кнотами нельзя управлять напрямую, их направляющие вообще недоступны, увидеть их можно при выбранным инструменте “Add 
Anchor Point Tool ” или “Delete Anchor Point Tool ”. 

Наличие на сегменте кнота делает изменение формы сегмента неконтролируемым.
При этом, только начиная с Illustrator CS5 стало возможным удалять кноты инструментом “Delete Anchor Point Tool ”, кликая по 

ним. В более ранних версиях был только один способ удалять кноты штатными средствами. Для этого нужно инструментом “Direct 
Selection Tool ” выделить прямоугольную область в которую попадает кнот (это при том, что самого кнота в этот момент не видно) и 
нажать Delete на клавиатуре.

Плагин MeshTormentor предоставляет возможность легко удалять кноты или преобразовывать их в вертексы. При этом он сам 
«страдает» синдромом создания кнотов, будьте бдительны.

Особенности цветовых переходов на границах мэша
Характер цветового перехода внутри ячеек мэшевой сетки, находящихся на границе мэша, отличается от остальных ячеек. Это 

хорошо видно на примере сравнения двух состыкованных мэшей и одного, полученного путем их сшивки:

Delete
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Для того чтобы устранить этот недостаток, необходимо добавить новый ряд ячеек и сделать его «невидимым»:

MeshTormentor дает возможность делать это автоматически, а также легко удалять такие «невидимые» ряды.

Существует шесть типов ячеек в зависимости от того, сколько и какие сегменты ячеек находятся на границе мэша.

Наибольший интерес представляют тип 1 и тип 6, у которых во всех направлениях цвет распределяется одинаково. Тип 1 самый 
приемлемый и отличается большей насыщенностью цвета возле нодов. Достигается это за счет нелинейного распределения цвета, в то 
время как тип 6 (представляющий собой одноячеечный мэш) имеет линейное распределение цвета.

1

2 3 45

6

1 2 3 4 5 6
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В Illustrator есть возможность преобразования линейного градиента в мэш командой меню Object -> Expand. При этом получаемый 
мэш несколько отличается от исходного градиента. Это происходит как раз по той причине, что у ячеек мэша нелинейное распределение 
цвета. А повторить исхдный градиент можно разбив этот мэш на отдельные одноячеечные мэши (либо если увеличить плотность сетки 
мэша, об этом ниже).

Почему увеличение плотности сетки мэша приводит к такому результату? Если увеличивать плотность плагином MeshTormentor, 
то это делается в несколько этапов, на каждом из которых плотность сетки увеличивается вдвое. Ниже показан нелинейный закон 
распределения цвета внутри ячейки и процесс ее разбиения. Нетрудно заметить, что общая форма этого распределения с каждой 
разбивкой стремится к линейной (показанной пунктиром).

Пипетка и мэш
“Eyedropper Tool ” берет цвет с поверхности мєша неправильно. Все ячейки мэша воспринимаются этим инструментом как 

ячейки типа 6. Т.е. только с одноячеечных мэшей цвет пипеткой берется правильно, либо в непосредственной близости от нодов во всех 
остальных случаях. Вот, например, слева мэш, а справа то, как этот же мэш “видит” “Eyedropper Tool ”:

 
В плагине MeshTormentor есть функция захвата цвета с поверхности мэша, и она имеет этот же недостаток, но в следующих 

обновлениях это скорее всего будет исправлено. В том числе возможно появится альтернативная пипетка, работающая только с мэшами, 
но работающая правильно.

Мертвые зоны
На поверхностях некоторых мэшей при большом масштабе просмотра документа могут попадаться области, в которых программа не 

видит этот мэш. Например, пипетка может взять цвет объекта, лежащего под мэшем. Эти области обычно представляют собой узкие 
короткие полосы, проходящие вдоль осей мэша (но не обязательно лежащие на линиях сетки) и никак не выделяются на общем фоне. 
Найти их самостоятельно крайне тяжело, однако c MeshTormentor при использовании функции захвата цвета с поверхности мэша, это 
вполне возможно.

Градиентная заливка

Мэш после Object -> Expand

Увеличенная плотность сетки мэша

Четыре отдельных мэша
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Плагин MeshTormentor
Ссылки

www.meshtormentor.com - основной сайт
facebook.com/meshtormentor - страница на Facebook
vk.com/meshtormentor - страница ВКонтакте
youtube.com/user/meshtormentor - канал на Youtube
meshtormentor@gmail.com - электронная почта

ru.vectorboom.com - уроки по векотрной графике, в том числе с использованием плагина MeshTormentor

Варианты плагина
Существует следующие вариации плагина, рассчитанные на различные версии Adobe Illustrator под Windows и MacOS:

Классическая
- для Windows, версии CS2, CS3, CS4, CS5
- для MacOS, версии CS3, CS4, CS5
Реализована в виде двух aip файлов, один для Windows, другой для MacOS.

MeshTormentorCS5
- для Windows, версия CS5
- для MacOS, версия CS5
Реализована в виде двух aip файлов, один для Windows, другой для MacOS.

MeshTormentorCS6
- для Windows, версия CS6 и CS6 (64bit)
- для MacOS, версия CS6
Реализована в виде универсального zxp файла.

Классическая версия отличается от остальных отсутствием поддержки работы с прозрачностями нодов мэша (которая появилась в 
CS5-й версии Иллюстратора).

Установка плагина
Для Классической версии и MeshTormentorCS5 установка производится копированием aip файла в каталог \Plug-ins\, находящийся 

по месту установки Иллюстратора (например C:\Program Files\Adobe\Adobe Illustrator CS2\Plug-ins\). При этом сам Illustrator не должен 
быть запущен.

Для MeshTormentorCS6 необходимо открыть zxp файл в программе Adobe Extension Manager CS6.

www.meshtormentor.com
http://www.facebook.com/meshtormentor
http://vk.com/meshtormentor
http://www.youtube.com/user/meshtormentor
mailto:meshtormentor%40gmail.com?subject=
http://ru.vectorboom.com
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Работа с плагином
Палитра инструментов плагина вызывается командой меню Window->Mesh Tormentor.
При работе с плагином сначала на рабочем поле Illustrator-а выделяются необходимые объекты, а потом нажимается соответсвующая 

кнопка на палитре инструментов MeshTormentor-а.
Многие функции плагина имеют несколько вариантов работы. Для вызова альтернативных вариантов работы необходимо в момент 

нажатия кнопки на палитре инструментов зажимать клавиши Ctrl и/или Alt на клавиатуре (в MasOS клавиши Command и Option). В 
результате может быть до четырех вариантов работы:

Windows MacOS
[] [] никакая клавиша на клавиатуре не зажата
[Ctrl] [Com] зажата клавиша Ctrl (Command в MacOS)
[Alt] [Opt] зажата клавиша Alt (Option в MacOS)
[Ctrl]+[Alt] [Com]+[Opt] одновременно зажаты клавиши Ctrl и Alt (Command и Option в MacOS)
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Функции плагина MeshTormentor
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Создание набора путей на основе сегментов мэша

Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] каждый путь соответствует последовательности сегментов
[Ctrl] [Com] каждый путь соответствует сегменту ячейки
[Alt] [Opt] каждый путь соответствует сегменту
[Ctrl]+[Alt] [Com]+[Opt] см. ниже

На основе каждого выделенного мэша создается отдельная группа “MeshGrid”, состоящая из путей, повторяющих форму сетки мэша.
При частичном выделении мэша, пути создаются только для выделенных сегментов. Сегмент считается выделенным, если выделены 

ограничивающие его узлы.

Группа “MeshGrid” содержит две подгруппы - “I-axis” и “J-axis”, соответствующие двум осям мэшевой сетки. В этих подгруппах 
содержатся пути с именами “J=0”, “J=1”, “J=2”, ... и “I=0”, “I=1”, “I=2”, ... Эти имена соответствуют координатам, вдоль которых проходят 
пути. Если путей с одинаковыми именами два или более, они объединяются в группу с таким же именем.

[ ] [Ctrl]
[Alt]

I =
 3

J 
= 

2I =
 1

I =
 0

J = 2

J = 1J = 1

J = 0

J = 0
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Если перед вызовом функции создать графический стиль с именем “[MT][Axis]”, то он будет применен к созданным путям. Графические 
стили с именами “[MT][Axis][I]” и “[MT][Axis][J]” будут применяться к путям, проходящим по осям I и J соответственно.

Создание набора путей на основе направляющих мэша

Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] см. выше
[Ctrl] [Com] см. выше
[Alt] [Opt] см. выше
[Ctrl]+[Alt] [Com]+[Opt] Создание набора путей на основе направляющих мэша

На основе каждого выделенного мэша создается отдельная группа “MeshPoints”, состоящая из путей, соответствующих нодам, 
вертексам, кнотам мэша, а также их направляющим.

Группа “MeshPoints” может содержать такие подгруппы:
•	 “Nodes” объединяет пути, соответствующие выделенным нодам
•	 “Vertices” объединяет пути, соответствующие выделенным вертексам
•	 “WithControls” объединяет пути, соответствующие направляющим выделенных нодов и вертексов
•	 “WithTrueControls” объединяет пути, соответствующие кнотам и их направляющим, а также настоящим направляющим 

выделенных нодов и вертексов

Группы “Nodes” и “Vertices” содержат одноточечные пути (пути состоящие из одной опорной точки), находящиеся на местах 
расположения соответствующих нодов и вертексов. Пути-вертексы носят имена “vertex”, а у путей-нодов имена формата “i,j”, где i и j - 
координаты нода на мэшевой сетка (например “0,0”, “4,6”, “0,3”).

Если выделенные сегменты не содержат кноты, то подгруппа “WithTrueControls” не создается. Если кноты в выделенных сегментах 
есть, то подгруппа “WithTrueControls” создается, а подгруппа “WithControls” создается скрытой. Эти две подгруппы взаимоисключают 
друг друга и должны отображаться поодиночке.

здесь есть кнот
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Группа “WithControls” содержит такие подгруппы:
•	 “Controls” объединяет пути, соответствующие управляющим точкам направляющих выделенных нодов и вертексов
•	 “LinesToControls” объединяет пути, соответствующие направляющим выделенных нодов и вертексов
Группа “WithTrueControls” содержит такие подгруппы:
•	 “Knots” объединяет пути, соответствующие выделенным кнотам
•	 “Controls” объединяет пути, соответствующие управляющим точкам настоящих направляющих выделенных нодов, вертексов и 

кнотов
•	 “LinesToControls” объединяет пути, соответствующие настоящим направляющим выделенных нодов, вертексов и кнотов
Группа “Knots” содержит одноточечные пути, находящиеся на местах расположения соответствующих кнотов. Эти пути носят имена 

“knot”.
Группа “Controls” содержит одноточечные пути, находящиеся на местах расположения соответствующих управляющих точек 

направляющих нодов, вертексов и кнотов.
Группа “LinesToControls” содержит линии, находящиеся на местах расположения соответствующих направляющих нодов, вертексов 

и кнотов.
В группах “Controls” и “LinesToControls” находятся подгруппы “Nodes”, “Vertices” и “Knots” (“Knots” создается только для группы 

“WithTrueControls”), внутри которых находятся группы с именами “i,j” (например “0,0”, “4,6”, “0,3”), “vertex” и “knot”, которые объединяют 
соответствующие пути. Пути могут носить такие имена: “-I”, “+I”, “-J”, “+J”, что соответствует направляющим в направлениях I’, I, J’, J 
соответственно.
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Одноточечные пути удобны, когда к ним применяется кисть типа “Scatter Brush”.

Если перед вызовом этой функции, создать графические 
стили с определенными именами, то они будут применены к 
соответствующим  путям.

Базовые имена графических стилей:
[MT][Node] - применяется к путям-нодам
[MT][Vertex] - применяется к путям-вертексам
[MT][Knot] - применяется к путям кнотам
[MT][Control] - применяется к путям, соответствующим 

управляющим точкам направляющих
[MT][LineToControl] - применяется к линиям-направляющим

Расширенные имена графических стилей первого уровня:
[MT][Control][I] - применяется к путям, соответствующим 

управляющим точкам направляющих, расположенных на оси I
[MT][Control][J] - применяется к путям, соответствующим 

управляющим точкам направляющих, расположенных на оси J
[MT][LineToControl][I] - применяется к линиям-направляющим, 

расположенным на оси I
[MT][LineToControl][J] - применяется к линиям-направляющим, 

расположенным на оси J

Расширенные имена графических стилей второго уровня:
[MT][Control][I][+] - применяется к путям, 

соответствующим управляющим точкам направляющих, 
расположенных в направлении I

[MT][Control][I][-] - применяется к путям, 
соответствующим управляющим точкам направляющих, 
расположенных в направлении I’

[MT][Control][J][+] - применяется к путям, 
соответствующим управляющим точкам направляющих, 
расположенных в направлении J

[MT][Control][J][-] - применяется к путям, 
соответствующим управляющим точкам направляющих, 
расположенных в направлении J’

[MT][LineToControl][I][+] - применяется к линиям-
направляющим, расположенным в направлении I

[MT][LineToControl][I][-] - применяется к линиям-
направляющим, расположенным в направлении I’

[MT][LineToControl][J][+] - применяется к линиям-
направляющим, расположенным в направлении J

[MT][LineToControl][J][-] - применяется к линиям-
направляющим, расположенным в направлении J’
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Показать оси и/или угловые ноды мэша

Выделение: мэш или несколько мэшей.

Windows MacOS
[] [] показать оси и угловые ноды мэша
[Ctrl] [Com] показать только оси мэша
[Alt] [Opt] показать только угловые ноды мэша

Для показа осей создается группа “Coords” с двумя кривыми. Красная кривая – ось I, синяя – ось J.
Для показа угловых нодов создается группа “Corner Nodes” с четырьмя квадратами.
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Переместить угловой нод
Выделение: угловой нод и валидный вертекс
Выделенный вертекс становится угловым нодом, а выделенный угловой нод - вертексом.
При успешном выполнении операции выделенным остается только перемещенный угловой нод.

Валидный вертекс – вертекс, находящийся на одном из примыкающих к выделенному угловому ноду сегменте ячейки.
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Преобразовать кноты в вертексы
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] кноты преобразуются в вертексы
[Ctrl] [Com] кноты удаляются
[Alt] [Opt] кноты удаляются с корректировкой направляющих

При частичном выделении кноты преобразуются в вертексы только на выделенных сегментах.
Корректировка заключается в том, что направляющие подгоняются под те, которые отображались при наличии кнотов.
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Преобразовать вертексы в кноты
Выделение: вертексы

Windows MacOS
[] [] вертексы преобразуются в кноты
[Ctrl] [Com] вертексы удаляются
[Alt] [Opt] вертексы удаляются с корректировкой направляющих

При корректировке направляющих вертексы преобразуются в кноты, после чего удаляются с корректировкой, как в предыдущей 
функции.
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Опции использования цвета и прозрачности нодов

Данные опции учитываются в следующих функциях:

Если опция выключена, то указанные функции не будут влиять на цвет или прозрачность нодов.
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Сдвиг цветов мэша
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] в направлении I
[Alt] [Opt] в направлении I’
[Ctrl] [Com] в направлении J
[Ctrl]+[Alt] [Com]+[Opt] в направлении J’

Циклический сдвиг цветов и прозрачностей нодов внутри простого региона и только в тех строках/столбцах, где есть хотя бы один 
выделенный нод.

Все ноды, между которыми происходит операция, выделяются.

I или I’ J или J’ 
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Отзеркаливание цветов мэша
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] вдоль оси I
[Ctrl] [Com] вдоль оси J

Отзеркаливание цвета и прозрачности нодов внутри простого региона. Операция происходит между парами нодов, если хотя бы 
один из них выделен.

Все ноды, между которыми происходит операция, выделяются.

I J
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Поворот цветов мэша
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] по часовой стрелке
[Alt] [Opt] против часовой стрелки

Поворот цвета и прозрачности нодов внутри простого региона. Операция происходит между тетрадами или парами нодов, если 
хотя бы один из них выделен. Если регион квадратен, то поворот происходит на 45 градусов, в противном случае - на 90.

Все ноды, между которыми происходит операция, выделяются.

Направления по часовой и против часовой стрелки относительные. Их истинное направление зависит от направлений осей мэша. 
Направление по часовой стрелке – это то направление, по которому нужно двигаться вокруг начального нода в пределах мэша от оси J 
до оси I.
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Клонирование цветов
Выделение: частично или полностью выделенные два или более мэша

Windows MacOS
[] [] с самого верхнего* на все остальные
[Alt] [Opt] с самого нижнего* на все остальные
[Ctrl] [Com] с самого верхнего* на все остальные с IJ корректировкой
[Ctrl]+[Alt] [Com]+[Opt] с самого нижнего* на все остальные с IJ корректировкой

* - если один из мэшей выделен как ключевой объект, то источником клонируемых цветов будет он.

Мэш-источник сравнивается по отдельности с каждым выделенными мэшем, в результате чего цвета и прозрачности региона мэша-
источника повторяются на регионе мэша-получателя. При этом регионы накладываются с учетом IJ корректировки (если она нужна) и 
определяется область их пересечения, внутри которой и происходит клонирование.

IJ корректировка:
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Распространить цвета
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] в направлении I
[Alt] [Opt] в направлении I’
[Ctrl] [Com] в направлении J
[Ctrl]+[Alt] [Com]+[Opt] в направлении J’

Внутри выделенного простого региона происходит распространение цветов нодов одной из сторон региона (какой именно, зависит 
от выбранного направления).  Распространяются только цвета выделенных нодов.

Если выделен регион 0xN, то, вне зависимости от выбранного направления, цвета выделенных нодов региона распространяются 
вдоль всего мэша.

Все ноды, между которыми происходит операция, выделяются.

I I’

J J’

0xN
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Заполнить паттерном
Выделение: частично выделенный мэш или мэши

Windows MacOS
[] [] заполнить все ноды
[Alt] [Opt] только в направлении I
[Ctrl] [Com] только в направлении J

Выделенный простой регион представляет прямоугольный цветовой паттерн, которым заполняются все остальные ноды.

Все ноды, между которыми происходит операция, выделяются.
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Добавить ряд ячеек нулевой толщины
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] Добавить ряд ячеек нулевой толщины на выделенных сторонах
[Ctrl] [Com] см. ниже
[Ctrl]+[Alt] [Com]+[Opt] см. ниже

Сторона считается выделенной, если выделены оба угловых нода, лежащих на этой стороне, либо если выделен хотя бы один 
боковой нод или вертекс, лежащий на этой стороне.

Добавление ряда ячеек нулевой толщины служит для коррекции характера цветового перехода на боковых ячейках мэша.

Если на выделенной стороне уже есть ряд ячеек нулевой толщины, то новый такой ряд не создается, а только выставляются цвета 
боковых нодов этого ряда.
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Удалить ряд ячеек нулевой толщины
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] см. выше
[Ctrl] [Com] Удалить ряд ячеек нулевой толщины на выделенных сторонах
[Ctrl]+[Alt] [Com]+[Opt] Удалить любой ряд ячеек на выделенных сторонах

[Ctrl]+[Alt]
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Разрезать мэш на два
Выделение: боковой нод мэша
Мэш разрезается на два по линии, проходящей через выделенный боковой нод.

Разделить ячейку на две
Выделение: два боковых вертекса, находящихся на противоположных сегментах одной ячейки.

Ячейка разделяется на две по прямой линии, проведенной между выделенными нодами. Мэш при этом остается цельным.
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Создать одноячеечный мэш на основе пути
Выделение: частично или полностью выделенный путь или пути

Windows MacOS
[] [] применить прозрачность пути ко всему мэшу
[Alt] [Opt] применить прозрачность пути к нодам мэша

Путь преобразуется в одноячеечный мэш. Нодами мэша становятся четыре самые острые опорные точки из выделенных. Все 
остальные опорные точки становятся кнотами мэша.

Минимальное число выделенных опорных точек - четыре. При меньшем числе мэш из пути создаваться не будет.
Ноды мэша заполняются одним цветом. Сам цвет зависит от того, какие цвета заливки и обводки у пути и включена ли в плагине 

опция использования цвета.
Если опция использования цвета выключена или у пути нет заливки и обводки, то ноды заливаются серым цветом.
Если у пути есть заливка, то ноды заливаются цветом заливки.
Если у пути нет заливки и есть обводка, то используется цвет обводки.

Также мэш наследует режим наложения от пути.
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Создать мэшевую сетку для кисти (Создать BMG)
Выделение: мэш или мэши

Меш преобразуется в специальную сетку, внешне напоминающую исходный мэш, и состоящую из путей, что позволяет использовать 
её, как элемент кисти.

BMG наследует режим наложения и прозрачность мэша.

Получить мэш из кистевой сетки (Получить мэш из BMG)
Выделение: специальная кистевая сетка (BMG) или несколько сеток.

Кистевая сетка преобразуется обратно в мэш.
Мэш наследует режим наложения и прозрачность BMG.
В полученном мэше нет ни одного вертекса, зато может быть очень много кнотов, будьте внимательны.
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Захват цветов с растрового объекта на все выделенные мэши
Выделение: растровый объект и частично или полностью выделенный мэш или мэши.

Windows MacOS
[] [] используя коррекцию на границе мэша
[Ctrl] [Com] не используя коррекцию на границе мэша
[Alt] [Opt] см. ниже
[Ctrl]+[Alt] [Com]+[Opt] см. ниже

Все выделенные ноды мэшей заливаются цветами, взятыми с поверхности растрового объекта, с тех координат, где эти ноды находятся. 
Если выделенный нод не попадает на растровый объект, то выделение с этого нода снимается.

В операции может принимать как встроенный так и прилинкованный растровый объект. Однако при использовании прилинкованного 
растра операция может выполнятся дольше, чем если этот же растр будет встроен в документ.

Коррекция на границе мэша заключается в том, что при захвате цветов для боковых и угловых нодов мэша, используются координаты 
этих нодов слегка “сдвинутые” вглубь мэша.

Захват цветов с поверхности самого нижнего мэша
Выделение: два или более частично или полностью выделенные мэши.

Windows MacOS
[] [] см. выше
[Ctrl] [Com] см. выше
[Alt] [Opt] используя коррекцию на границе мэша
[Ctrl]+[Alt] [Com]+[Opt] не используя коррекцию на границе мэша

Данная функция пока что имеет ряд недостатков, которые должны будут исправлены в следующих обновлениях.
Эта функция аналогична захвату цветов с растра, но вместо растра используется самый нижний выделенный мэш.
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Сглаживание узлов
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] сгладить направляющие выделенных нодов и вертексов, угловые ноды игнорируются
[Alt] [Opt] сгладить направляющие только в направлении I
[Ctrl] [Com] сгладить направляющие только в направлении J
[Ctrl]+[Alt] [Com]+[Opt] сгладить направляющие только угловых нодов

[ ] [Alt] [Ctrl] [Ctrl]+[Alt]
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Выставить направляющие под 90 градусов
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] воздействовать на направляющие в обоих направлениях
[Alt] [Opt] не воздействовать на направляющие в направлении I
[Ctrl] [Com] не воздействовать на направляющие в направлении J
[Ctrl]+[Alt] [Com]+[Opt] см. ниже

Направляющие выделенных нодов сглаживаются и выставляются под 90 градусов друг к другу.

Развернуть на 180 градусов направляющие региона 0xN
Выделение: регион 0xN

Windows MacOS
[] [] см. выше
[Alt] [Opt] см. выше
[Ctrl] [Com] см. выше
[Ctrl]+[Alt] [Com]+[Opt] Развернуть на 180 градусов направляющие региона 0xN

Направляющие, проходящие поперек направления региона, разворачиваются на 180 градусов.

[ ] [Alt] [Ctrl]



36

Направляющие 1/3
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] все направляющие выделенных нодов и вертексов
[Alt] [Opt] только направляющие между выделенными нодами и вертексами в направлении I
[Ctrl] [Com] только направляющие между выделенными нодами и вертексами в направлении J
[Ctrl]+[Alt] [Com]+[Opt] только направляющие между выделенными нодами и вертексами в обоих направлениях

Длина направляющей становится равна 1/3 от расстояния между нодом (вертексов) и соседним (в сторону направляющей) нодом 
(вертексом).
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Направляющие 0
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] все направляющие выделенных нодов и вертексов
[Alt] [Opt] только направляющие между выделенными нодами и вертексами в направлении I
[Ctrl] [Com] только направляющие между выделенными нодами и вертексами в направлении J
[Ctrl]+[Alt] [Com]+[Opt] только направляющие между выделенными нодами и вертексами в обоих направлениях

Длина направляющей становится равна нулю.

Выравнивание по вертикали
Выделение: частично выделенный мэш или мэши

Windows MacOS
[] [] выровнять вертикально по центру
[Alt] [Opt] выровнять вертикально по верхнему краю
[Ctrl] [Com] выровнять вертикально по нижнему краю

Выделенные ноды и вертексы выравниваются по выбранной стороне.

Выравнивание по горизонтали
Выделение: частично выделенный мэш или мэши

Windows MacOS
[] [] выровнять горизонтально по центру
[Alt] [Opt] выровнять горизонтально по правому краю
[Ctrl] [Com] выровнять горизонтально по левому краю

Выделенные ноды и вертексы выравниваются по выбранной стороне.
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Выделить ноды/вертексы
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] оставить выделенными только ноды
[Alt] [Opt] оставить выделенными только вертексы
[Ctrl] [Com] инвертировать выделение

Выделить регион
Выделение: частично выделенный мэш или мэши
Выделяются все ноды и вертексы, попадающие в выделенный регион.

Выделить периметр региона
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] выделить весь периметр
[Alt] [Opt] выделить узлы вдоль оси I
[Ctrl] [Com] выделить узлы вдоль оси J

Выделить все узлы вдоль выделенных строк/столбцов
Выделение: частично выделенный мэш или мэши

Windows MacOS
[] [] выделить строки (направление I) и столбцы (направление J)
[Alt] [Opt] выделить только строки (направление I)
[Ctrl] [Com] выделить только столбцы (направление J)

Сдвиг выделенных нодов
Выделение: частично выделенный мэш или мэши

Windows MacOS
[] [] в направлении I
[Alt] [Opt] в направлении I’
[Ctrl] [Com] в направлении J
[Ctrl]+[Alt] [Com]+[Opt] в направлении J’

Циклический сдвиг выделенных нодов вдоль всего мэша в выбранном направлении.
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Выровнять сегменты вдоль пути
Выделение: регион 0xN мэша и путь

Windows MacOS
[] [] в прямом направлении
[Alt] [Opt] в обратном направлении
[Ctrl] [Com] в прямом направлении со сменой стороны входа
[Ctrl]+[Alt] [Com]+[Opt] в обратном направлении со сменой стороны входа

Сегменты выделенного региона выравниваются вдоль выделенного пути. При этом выравниваются направляющие нодов региона, 
чтобы регион полностью повторял форму пути, на сегментах могут быть созданы кноты. Направляющие второй оси выставляются 
перпендикулярно, а их размеры изменяются согласно правилу 1/3, кроме того изменяются размеры соседних к ним направляющих.

Если у мэша выделен не регион 0xN, то в выравнивании принимает участие ближайшая к пути сторона выделенного региона.

[ ] [Alt]

[Ctrl] [Ctrl]+[Alt]
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Сшить мэши (со сведением узлов)
Выделение: частично или полностью выделенные два или более мэша

Windows MacOS
[] [] в прямом направлении
[Alt] [Opt] в обратном направлении
[Ctrl] [Com] в прямом направлении используя вторую пару сторон
[Ctrl]+[Alt] [Com]+[Opt] в обратном направлении используя вторую пару сторон

Два верхних выделенных мэша “сшиваются” в один. При этом у каждого из них определяется сшиваемая сторона - регион 0xN на 
границах которого обязательно находятся угловые ноды. Если число ячеек на сшиваемых сторонах разное, то оно выравнивается до 
большего. Все узлы на сшиваемых сторонах попарно сводятся в одну точку, цвета и прозрачности нодов усредняются.

Результирующий мэш наследует режим наложения и прозрачность самого верхнего мэша из сшиваемой пары.
Направления осей результирующего мэша определяет также самый верхний мэш.

Сшить мэши (с добавлением нового ряда ячеек)
Выделение: частично или полностью выделенные два или более мэша

Windows MacOS
[] [] в прямом направлении
[Alt] [Opt] в обратном направлении
[Ctrl] [Com] в прямом направлении используя вторую пару сторон
[Ctrl]+[Alt] [Com]+[Opt] в обратном направлении используя вторую пару сторон

Два верхних выделенных мэша “сшиваются” в один. При этом у каждого из них определяется сшиваемая сторона - регион 0xN на 
границах которого обязательно находятся угловые ноды. Если число ячеек на сшиваемых сторонах разное, то оно выравнивается до 
большего. Между сшиваемыми сторонами формируется новый ряд ячеек, обеспечивающий плавный переход одного исходного мэша в 
другой.

Результирующий мэш наследует режим наложения и прозрачность самого верхнего мэша из сшиваемой пары.
Направления осей результирующего мэша определяет также самый верхний мэш.
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Сшить вместе состыкованные мэши
Выделение: состыкованные мэши

Если выделенные отдельные мэши стыкуются между собой угловыми нодами и при этом формируют правильную мэшевую сетку, то 
они объединяются в один мэш.

Создать мэш из состыкованных путей
Выделение: состыкованные пути

Если выделенные пути стыкуются между собой крайними опорными точками и при этом формируют правильную мэшевую сетку 
(будучи сегментами ячеек), то на их основе создается мэш. Пути, у которых одна или обе крайние опорные точки не стыкуются с 
другими, удаляются и не учитываются.
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Сшить мэш с путем
Выделение: частично или полностью выделенный мэш и путь (несколько путей)

Windows MacOS
[] [] в прямом направлении
[Alt] [Opt] в обратном направлении
[Ctrl] [Com] в прямом направлении со сменой стороны входа
[Ctrl]+[Alt] [Com]+[Opt] в обратном направлении со сменой стороны входа

С одной из сторон мэша добавляется новый ряд ячеек, граница которого повторяет форму выделенного пути. Новые ноды заливаются 
цветом обводки пути, или заливки (если у пути нет обводки), или серым (если у пути нет ни заливки ни обводки).

Выделение: два или более пути

Windows MacOS
[] [] в прямом направлении
[Alt] [Opt] в обратном направлении

Два верхних пути объединяются в одноячеечный мэш. Пути формируют противоположные сегменты мэша.

[ ] [Alt]

[Ctrl] [Ctrl]+[Alt]

[ ] [Alt]
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Увеличить плотность сетки
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] в обоих направлениях
[Alt] [Opt] только в направлении I
[Ctrl] [Com] только в направлении J

Ячейки, проходящие через выделенный регион, разделяются на две в выбранных направлениях.
Данная функция не затрагивает ячейки нулевой толщины на границах мэша (полученные при помощи соответствующей функции), 

если увеличение плотности происходит вдоль нулевой толщины.

Уменьшить плотность сетки
Выделение: частично или полностью выделенный мэш или мэши

Windows MacOS
[] [] в обоих направлениях
[Alt] [Opt] только в направлении I
[Ctrl] [Com] только в направлении J

Ячейки, проходящие через выделенный регион, попарно объединяются в выбранных направлениях. В местах, где были ноды, 
образуются кноты.

Данная функция не затрагивает ячейки нулевой толщины на границах мэша (полученные при помощи соответствующей функции), 
если уменьшение плотности происходит вдоль нулевой толщины.

[ ] [Alt] [Ctrl]

[ ] [Alt] [Ctrl]


